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Package Contents

Contents of Package:

D-Link AirPlus G DI-524
802.11/2.4GHz Wireless Router

Power Adapter-DC 7.5V, 1.5A

Manual and Warranty on CD

Quick Installation Guide

Ethernet Cable (All the DI-524’s Ethernet ports are Auto-MDIX)

Note: Using a power supply with a different voltage rating than the one included with
the DI-524 will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

System Requirements for Configuration:
B Ethernet-Based Cable or DSL Modem

B Computers with Windows, Macintosh, or Linux-based
operating systems with an installed Ethernet adapter

B Internet Explorer Version 6.0 or Netscape Navigator
Version 7.0 and Above



Introduction

The D-Link AirPlus G DI-524 High-Speed Wireless Router is an 802.11g high-
performance, wireless router that supports high-speed wireless networking at home,
at work or in public places.

Unlike most routers, the DI-524 provides data transfers at up to 108 Mbps (compared
to the standard 54 Mbps) when used with other D-Link AirPlus G products. The 802.11g
standard is backwards compatible with 802.11b products. This means that you do not
need to change your entire network to maintain connectivity. You may sacrifice some of
802.11g’s speed when you mix 802.11b and 802.11g devices, but you will not lose the
ability to communicate when you incorporate the 802.11g standard into your 802.11b
network. You may choose to slowly change your network by gradually replacing the
802.11b devices with 802.11g devices .

In addition to offering faster data transfer speeds when used with other 802.11g products,
the DI-524 has the newest, strongest, most advanced security features available today.
When used with other 802.11g WPA (WiFi Protected Access) and 802.1x compatible
products in a network with a RADIUS server, the security features include:

WPA: Wi-FiProtected Access authorizes and identifies users based on a secret key
that changes automatically at a regular interval. WPA uses TKIP (Temporal
Key Integrity Protocol) to change the temporal key every 10,000 packets (a
packet is a kind of message transmitted over a network.) This insures much
greater security than the standard WEP security. (By contrast, the older WEP
encryption required the keys to be changed manually.)

802.1x: Authentication is a first line of defense against intrusion. In the Authentication
process the server verifies the identity of the client attempting to connect to the
network. Unfamiliar clients would be denied access.

For home users that will not incorporate a RADIUS server in their network, the security
for the DI-524, used in conjunction with other 802.11g products, will still be much stronger
than ever before. Utilizing the Pre Shared Key mode of WPA, the DI-524 will obtain a
new security key every time it connects to the 802.11g network. You only need to input
your encryption information once in the configuration menu. No longer will you have to
manually input a new WEP key frequently to ensure security, with the DI-524, you will
automatically receive a new key every time you connect, vastly increasing the safety
of your communications.



Connections

All Ethernet Ports (WAN and LAN)
are auto MDI/MDIX, meaning you
can use either a straight-through or
a crossover Ethernet cable.

Pressing the
Reset Button
restores the
router to its
original factory
default settings.

Auto MDI/MDIX
LAN ports
automatically sense
the cable type
when connecting to
Ethernet-enabled
computers.

The Auto MDI/ Receptor
MDIX WAN port is for the
the connection for Power

the Ethernet cable Adapter
to the Cable or

DSL modem




LEDs

WAN LED

blinks during data
transmission

A solid light indicates
connection on the
WAN port. This LED

WLAN LED

A solid light
indicates that the
wireless segment
is ready. This
LED blinks during
wireless data
transmission

wireless )
Router

A solid light

POWER LED

indicates a proper

connection to the
power supply

STATUS

A blinking light
indicates that the
DI-524 is ready

LOCAL
NETWORK LED

a connection to an
Ethernet-enabled

computer on ports
1-4. This LED
blinks during data
transmission

A solid light indicates




Features

B Fully compatible with the 802.11g standard to provide a wireless data rate of
up to 54Mbps

B Backwards compatible with the 802.11b standard to provide a wireless data
rate of up to 11Mbps

B WPA (Wi Fi Protected Access) authorizes and identifies users based on a
secret key that changes automatically at a regular interval, for example:

B TKIP (Temporal Key Integrity Protocol), in conjunction with a RADIUS
server, changes the temporal key every 10,000 packets, ensuring
greater security

B Pre Shared Key mode means that the home user, without a RADIUS
server, will obtain a new security key every time the he or she connects
to the network, vastly improving the safety of communications on the
network.

802.1x Authentication in conjunction with the RADIUS server verifies the
identity of would be clients

Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing)

User-friendly configuration and diagnostic utilities

Operates in the 2.4GHz frequency range

Connects multiple computers to a Broadband (Cable or DSL) modem to
share the Internet connection

Advanced Firewall features
W Supports NAT with VPN pass-through, providing added security
W MAC Filtering
M P Filtering
B URL Filtering

B Domain Blocking
M Scheduling

m DHCP server supported enables all networked computers to automatically
receive |P addresses

B Web-based interface for Managing and Configuring

B Access Control to manage users on the network

Supports special applications that require multiple connections

B Equipped with 4 10/100 Ethernet ports, 1 WAN port, Auto MDI/MDIX



Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and
compatible high-speed wireless connectivity within your home, business or public
access wireless networks. D-Link wireless products will allow you access to the data
you want, when and where you want it. You will be able to enjoy the freedom that
wireless networking brings.

AWLAN is a cellular computer network that transmits and receives data with radio signals
instead of wires. WLANSs are used increasingly in both home and office environments,
and public areas such as airports, coffee shops and universities. Innovative ways to
utilize WLAN technology are helping people to work and communicate more efficiently.
Increased mobility and the absence of cabling and other fixed infrastructure have proven
to be beneficial for many users.

Wireless users can use the same applications they use on a wired network. Wireless
adapter cards used on laptop and desktop systems support the same protocols as
Ethernet adapter cards.

People use wireless LAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-time
information can significantly improve worker efficiency.

Low Implementation Costs — WLANs are easy to set up, manage, change
and relocate. Networks that frequently change can benefit from WLANs ease of
implementation. WLANSs can operate in locations where installation of wiring may be
impractical.

Installation and Network Expansion - Installing a WLAN system can be fast and
easy and can eliminate the need to pull cable through walls and ceilings. Wireless
technology allows the network to go where wires cannot go - even outside the home
or office.

Scalability — WLANs can be configured in a variety of topologies to meet the needs
of specific applications and installations. Configurations are easily changed and range
from peer-to-peer networks suitable for a small number of users to larger infrastructure
networks to accommodate hundreds or thousands of users, depending on the number

of wireless devices deployed.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices.



Wireless Basics (continued)

Standards-Based Technology
The DI-524 Wireless Broadband Router utilizes the new 802.11g standard.

The IEEE 802.11g standard is an extension of the 802.11b standard. It increases the
data rate up to 54 Mbps within the 2.4GHz band, utilizing OFDM technology.

This means that in most environments, within the specified range of this device, you
will be able to transfer large files quickly or even watch a movie in MPEG format over
your network without noticeable delays. This technology works by transmitting high-
speed digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division
Multiplexing) technology. OFDM works by splitting the radio signal into multiple
smaller sub-signals that are then transmitted simultaneously at different frequencies
to the receiver. OFDM reduces the amount of crosstalk (interference) in signal
transmissions.

The DI-524 is backwards compatible with 802.11b devices. This means that if you have
an existing 802.11b network, the devices in that network will be compatible with 802.11g
devices at speeds of up to 11Mbps in the 2.4GHz range.



Wireless Basics (continued)

Installation Considerations

The D-Link AirPlus G DI-524 lets you access your network, using a wireless connection,
from virtually anywhere within its operating range. Keep in mind, however, that the
number, thickness and location of walls, ceilings, or other objects that the wireless signals
must pass through, may limit the range. Typical ranges vary depending on the types of
materials and background RF (radio frequency) noise in your home or business. The

key to maximizing wireless range is to follow these basic guidelines:

Keep the number of walls and ceilings between the DI-524 and other network
devices to a minimum - each wall or ceiling can reduce your D-Link wireless
product’s range from 3-90 feet (1-30 meters.) Position your devices so that
the number of walls or ceilings is minimized.

Be aware of the direct line between network devices. A wall that is 1.5 feet
thick (.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter)
thick. At a 2-degree angle it looks over 42 feet (14 meters) thick! Position
devices so that the signal will travel straight through a wall or ceiling (instead
of at an angle) for better reception.

Building Materials can impede the wireless signal - a solid metal door or
aluminum studs may have a negative effect on range. Try to position wireless
devices and computers with wireless adapters so that the signal passes
through drywall or open doorways and not other materials.

Keep your product away (at least 3-6 feet or 1-2 meters) from electrical
devices or appliances that generate extreme RF noise.

10



Getting Started

J Cable/DSL Modem
7DI-524 @

802.11g/2.4GHz
'l\'lleless Router

e,
@ o pbul® =
g Computer 2

Computer 3 @

You will need broadband Internet access (a Cable or DSL-subscriber line into
your home or office)

e Consult with your Cable or DSL provider for proper installation of the modem

Connect the Cable or DSL modem to the DI-524 Wireless Broadband Router
(see the printed Quick Installation Guide included with your router.)

If you are connecting a desktop computer to your network, install the D-Link
AirPlus G DWL-G510 wireless PCI adapter into an available PCI slot on your
desktop computer. You may also install the DWL-G510, or the DWL-520.
(See the printed Quick Installation Guide included with the network adapter.)

@ Install the D-Link DWL-G630 wireless Cardbus adapter into a laptop computer.
(See the printed Quick Installation Guide included with the DWL-G630.)

Install the D-Link DFE-530TX+ adapter into a desktop computer. The four
Ethernet LAN ports of the DI-524 are Auto MDI/MDIX and will work with both
Straight-Through and Cross-Over cable.

(See the printed Quick Installation Guide included with the DFE-530TX+.) 11



Using the Configuration Menu

Whenever you want to configure your network or the
DI-524, you can access the Configuration Menu by
opening the web-browser and typing in the IP Address
of the DI-524. The DI-524 default IP Address is shown
at right:

u Open the web browser
[ | Type in the IP Address of

the Router (http://192.168.0.1)

Note: if you have changed the default IP Address assigned to
the DI-524, make sure to enter the correct IP Address.

[ ] Type admin in the User
Name field

[ ] Leave the Password blank

[ ] Click OK

Home > Wizard

D-Link

BulImg Netwarks for People

screen will appear. D |

Please refer to the

.

Bz EdE

\a}ﬂa[k -

wid o ] http://192.168.0.1

Weww  F

poks  Help

wores
] (2] F

= L

=5
3

DI-524
User name:

Password:

Connect to 192.168.0.1

1@ acmin |
\ |

[ Remember my password

AirPlus G

. 802.11g9/2.4GHz Wireless Router
The Home>Wizard LT S Advanced | Tools

The DI-524 is an Ethernet Broadband Router ideal for home networking and small

Status Help

QUICk InSta”atIOI’l business networking. The setup w!zanl wiI_I guide you to m.:nligure the DI?N to
Guide for more Yeaekd ity ol i el e e
. . . by step to configure the DI.524.
information regarding = Y
the Setup Wizard. F—
il
LAN 0
el =
These buttons a Clicking Apply will save changes made to the page
appear on most of the Apply
configuration screens
in this section. Please Q Clicking Cancel will clear changes made to the page
click on the appropriate  Cancel
button at the bottom
of each screen after o Clicking Help will bring up helpful information regarding the page

you have made a Help
configuration change.

@ Clicking Restart will restart the router. (Necessary for some changes.)

Restart

12



Using the Configuration Menu (continued)

Network ID(SSID)-

Channel-

Security-

WEP Encryption-

Key Mode-

Keys 1-4-

Home > Wireless

D-Link

BuIKINg Networks for People

AirPlus G
802.11g/2.4GHz Wireless Router
LT M Advanced Tools Status Help

DI-524 l

Wizard

These are the wireless settings for the AP(Access Poinf) portion

Metwork ID(SS10) dletaut

Channel 'Eiiv‘

Security = v
Wireless WWEP Encryption 64 Bit Vi
Key Mode [ﬁi_:\
WEP Key 1 @ | |
Key 2 O | ‘
LAN Key3 O | |
Key 4 o | ‘

DHCP

Input 10 HEX characters. (HEX is 0~8 A~F, ar a~f)

@ 90

Apply Cancel Help

Service Set Identifier (SSID) is the name designated for a specific
wireless local area network (WLAN). The SSID’s factory default
setting is default. The SSID can be easily changed to connect
to an existing wireless network or to establish a new wireless
network.

6 is the default channel. All devices on the network must share
the same channel. (Note: The wireless adapters will automatically
scan and match the wireless setting.)

Select None, WEP, 802.1X, WPA-PSK or WPA. None is the
default setting. (Note: if you enable encryption on the DI-524,
please make sure that you also enable encryption on all the
wireless clients, or wireless connection will not be established.)

Select the level of encryption desired: 64-bit, or 128-bit
Select HEX or ASCII

Input up to 4 WEP keys; select the one you wish to use.

13




Using the Configuration Menu (continued)
Home > WAN > Dynamic IP Address

Dynamic
IP Address-

Host Name-

MAC Address-

Clone
MAC Address-

Primary/
Secondary DNS
Address-

MTU-

Auto-reconnect-

D-Link

Bulxiing Netwarks for People

APlus G

802.11g/2.4GHz Wireless Router

Home [LUUETT-N Tools Status Help
DI-524 ]
‘- Please selectthe appropriate option to connect to your ISP
@ Dynamic IP Address Choose this option to obtain an IP address automatically
from yaur ISP (Far mast Cable modem users)
™ Wizara ¢ Stalic IP Address Choose this option to set static IP infarmation pravided to
wou by your ISP
— ¢ PPPoE Ghoose this option ifyaur ISP uses PRPoE. (Far most DSL
Wireless users)
3 Others PPTP , BigPond Cable , L2TP and Telia.
WAN
Hast Mame i optional
e [ (R )
o o Fher e ez s |
j—
DHCP —
Primary DNS Address [o0.00 |
Secondary DNS Address |pooo |
MTU 150 |
Auto-reconnect O Enabled @& Disabled
Apply Cancel Help

Choose Dynamic IP Address to obtain IP Address information
automatically from your ISP. Select this option if your ISP does
not give you any IP numbers to use. This option is commonly
used for Cable modem services.

The Host Name is optional but may be required by some ISPs.
The default host name is the device name of the Router and
may be changed.

The default MAC Address is set to the WAN'’s physical interface
MAC address on the Broadband Router. It is not recommended
that you change the default MAC address unless required by
your ISP.

The default MAC address is set to the WAN’s physical interface
MAC address on the Broadband Router. You can use the “Clone
MAC Address” button to copy the MAC address of the Ethernet
Card installed by your ISP and replace the WAN MAC address
with the MAC address of the router. It is not recommended
that you change the default MAC address unless required by
your ISP.

Enter a DNS Address if you do not wish to use the one
provided by your ISP.

Enter an MTU value only if required by your ISP. Otherwise,
leave it a the default setting.

Select Enabled or Disabled. 14



Using the Configuration Menu (continued)

Home > WAN > Static IP Address

Qu.!v‘ai.g}lmf AirPlus G

802.11g/2.4GHz Wireless Router
Home [UVETT-TT RS -7 1E Status Help
DI-524 l
‘- P\éase selectthe appropriate option to connect to your ISP
& Dynamic IF Address Chooge this option to obtain an IP address automatically
from your ISP. (For most Cable modem users)
Wizard ® Static IP Address Chooge this option to set static IP information provided to
you by your ISP,
e (3 PFPoE Choose this option ifyour ISP uses PPPOE. (For most DSL
Wireless users)
@] Others PPTP, BigPond Cahle , L2TP and Telia.
WAN
—_— IP Adress T
LAN —_—
Subnet Mask |pnoo |
DHCP ISP Gateway Address 0000

Prirnary DMS Address

Secondary DNS Address

MTU

@ © 0

Apply Cancel Help

Static IP Address- Choose Static IP Address if all WAN IP information is provided
to you by your ISP. You will need to enter in the IP address,
subnet mask, gateway address, and DNS address(es) provided
to you by your ISP. Each IP address entered in the fields must
be in the appropriate IP form, which are four octets separated
by a dot (x.x.x.x). The Router will not accept the IP address if
it is not in this format.

IP Address- Input the public IP Address provided by your ISP

Subnet Mask- Input your Subnet mask. (All devices in the network must have
the same subnet mask.)

ISP

Gateway Address- Input the public IP address of the ISP to which you are
connecting

Primary

DNS Address- Input the primary DNS (Domain Name Server) IP address
provided by your ISP

Secondary

DNS Address- This is optional

MTU- Enter an MTU value only if required by your ISP. Otherwise,
leave it at the default setting. 15



Using the Configuration Menu (continued)

Please be sure
to remove any

existing PPPoE client
software installed on
your computers.

Choose PPPoE (Point
to Point Protocol over
Ethernet) if your
ISP uses a PPPoE
connection. Your
ISP will provide you
with a username and
password. This option
is typically used for
DSL services. Select
Dynamic PPPoE to
obtain an IP address
automatically for your
PPPoE connection.
Select Static PPPoE to
use a static IP address
for your PPPoeE
connection.

PPPOE-

User Name-

Retype Password-

Service Name-
IP Address-

Primary DNS
Address-

Secondary DNS
Address-

Home > WAN > PPPoE
D-Link

Bulnimg Networks for People

AirPlus G
802.11g/2.4GHz Wireless Router

Advanced Tools Status

Home

Hel
DI-524 l -

Please selectthe appropriate option to connect tayour ISP,

Choose this option to obtain an IP address automatically
fram your ISP, (For most Cable modem users)

Choose this aption to set static IP information provided to
you by your ISP

Choose this aption if your ISP uses PPPoE. (For most DSL
users)

PPTP, BigPond Cahle , L2TP and Telia.

) Dynamic IP Address
Wizard () Static IP Address

® PPPOE

0B f

Wireless
) Gthers

WAN

N (& Dynamic PPPoE O Static PFPoE
UserMame [

il

DHCP Pagssword
Retype Password
Senvice Name

IP Address

Primary DNS Address
Secondary DNS Address
Maximurn Idle Time

MTU

Connect mode select O Atwaye-on O Manual @ Connecton-demand

@ 90O

Choose this option if your ISP uses PPPoE. (Most DSL users
will select this option.)

Dynamic PPPoE- receive an IP Address automatically from your ISP.
Static PPPoE-you have an assigned (static) IP Address.

Your PPPoE username provided by your ISP.

Re-enter the PPPoE password

Enter the Service Name provided by your ISP (optional).

This option is only available for Static PPPoE. Enter the static
IP Address for the PPPoE connection.

Primary DNS IP address provided by our ISP

This option is only available for Static PPPoE. Enter the static
IP Address for the PPPoE connection.

(Continued on the next page)

16



Using the Configuration Menu (continued)

Home > WAN > PPPoE continued

MTU-

Auto-reconnect-

Maximum Transmission Unit-1492 is the default setting-you
may need to change the MTU for optimal performance with
your specific ISP.

If enabled, the DI-524 will automatically connect to your ISP after
your system is restarted or if the PPPoE connection is dropped.

Home > LAN

D-Link AirPlus G

802.11g/2.4GHz Wireless Router

Home [CVETTETHES (TS Status Help

DI-524 L

The IP address ofthe DI-524
P Address 18218801 |

Wizard Subnet Mask 255,255,250 |

Domain Name ‘ |

900

Apply Cancel Help
=l

LAN is short for Local Area Network. This is considered your internal network. These are
the IP settings of the LAN interface for the DI-524. These settings may be referred to as
Private settings. You may change the LAN IP address if needed. The LAN IP address
is private to your internal network and cannot be seen on the Internet.

IP Address-

Subnet Mask-

The IP address of the LAN interface. The default IP address
is: 192.168.0.1

The subnet mask of the LAN interface.
The default subnet mask is 255.255.255.0

Local Domain-Name- This field is optional. Enter in the local domain name.

17



Using the Configuration Menu (continued)

Home > DHCP
D-Link

BUIKING NETwWorks 101 People

AirPlus G
802.119/2.4GHz Wireless Router
Advanced Status Help

Tools
DI-524 l

The DI-424 can he setup as a DHCP Server to distribute IP addresses to the LAN netwark

DHCP Server & Enabled O Disakled

192.188.0/100

192.168.0/19

Wizard Starting IP Address

Ending IP Address

Lease Time

Wireless [1weee B8)

00 ¢

i Static DHCP is used to allow DHCF server to assign same IP to specific MAC address

LAN

DHCP

© Enabled O Disabled

Mame |

IP Address  192.182.0,

wecadmess| L L L]
DHCP Client | -- select one - ~|

Apply Cancel Help
 Name IP Address MAC Address

Host Mame 1P Address MAC Address Expired Tirme

DHCP stands for Dynamic Host Control Protocol. The DI-524 has a built-in DHCP
server. The DHCP Server will automatically assign an IP address to the computers on
the LAN/private network. Be sure to set your computers to be DHCP clients by setting
their TCP/IP settings to “Obtain an IP Address Automatically.” When you turn your
computers on, they will automatically load the proper TCP/IP settings provided by the
DI-524. The DHCP Server will automatically allocate an unused IP address from the
IP address pool to the requesting computer. You must specify the starting and ending
address of the IP address pool.

DHCP Server- Select Enabled or Disabled. The default setting is Enabled.
Starting

IP Address- The starting IP address for the DHCP server’s IP assignment
Ending

IP Address- The ending IP address for the DHCP server’s IP assignment

Lease Time- The length of time for the IP lease. Enter the Lease time. The

default setting is one hour

18



Using the Configuration Menu (continued)

Advanced > Virtual Server

D-Link

BUIMIMY NErworKs 10r People

AirPlus G

802.11g/2.4GHz Wireless Router
| Home WVUIZULITE Tools Status Help
DI-524 I
i Virtual Server is used to allow Internet users access to LAN services.
OEnabled O Disabled
Virtual Server Mlams |—|
Private IP 162,168 u |
Protocol Type |_T_(_:_P__1 |
Private Port |
—
Filter Fuhlic Part |
Schedule Q Aways
e —
ARl O From  Time |00 |
day|sun ta[sun ]
— [3un ¥ ta|Sun v
— @ O O
DMZ Apply Cancel Help
Mame Private [P Protocol Schedule
Wirtual Semer FTP 0000 TCP21i21  ahways E)]
Wirtual Semer HTTP 0000 TCPBOIB0  ahways Ed]
virtual Server HTTPS 0.00.0 TCP 4431443 ahways EL}
virtual Server DNS 0.00.0 UDP 53763  always EL ]

The DI-524 can be configured as a virtual server so that remote users accessing Web or
FTP services via the public IP address can be automatically redirected to local servers
in the LAN (Local Area Network).

The DI-524 firewall feature filters out unrecognized packets to protect your LAN network
so all computers networked with the DI-524 are invisible to the outside world. If you wish,
you can make some of the LAN computers accessible from the Internet by enabling Virtual
Server. Depending on the requested service, the DI-524 redirects the external service

request to the appropriate server within the LAN network.

The DI-524 is also capable of port-redirection meaning incoming traffic to a particular
port may be redirected to a different port on the server computer.

Each virtual service that is created will be listed at the bottom of the screen in the
Virtual Servers List. There are pre-defined virtual services already in the table. You
may use them by enabling them and assigning the server IP to use that particular
virtual service.

19



Using the Configuration Menu (continued)

Advanced > Virtual Server continued

Virtual Server- Select Enabled or Disabled

Name- Enter the name referencing the virtual service

Private IP- The server computer in the LAN (Local Area Network) that will
be providing the virtual services.

Protocol Type- The protocol used for the virtual service

Private Port- The port number of the service used by the Private IP com-

Public Port- The port number on the WAN (Wide Area Network) side that

will be used to access the virtual service.

Schedule- The schedule of time when the virtual service will be enabled.
The schedule may be set to Always, which will allow the
particular service to always be enabled. If it is set to Time,
select the time frame for the service to be enabled. If the
system time is outside of the scheduled time, the service will

be disabled.

Example #1: If you have a Web server that you wanted Internet users
to access at all times, you would need to enable it. Web
(HTTP) server is on LAN (Local Area Network) computer
192.168.0.25. HTTP uses port 80, TCP.
Name: Web Server
Private IP: 192.168.0.25
Protocol Type: TCP
Private Port: 80
Public Port: 80

Schedule: always

20



Using the Configuration Menu (continued)

Advanced > Virtual Server continued

withial Sepewrs Lisd
Hair=s Himvafe IH Hrofocod T -1 [ [
Eovarh ol S HL P TH? THA [ M L e B | e 12

' ? Click on this icon to edit the virtual service

¥ tl Click on this icon to delete the virtual service

Example #2:

If you have an FTP server that you wanted Internet users to access by WAN port
2100 and only during the weekends, you would need to enable it as such. FTP
server is on LAN computer 192.168.0.30. FTP uses port 21, TCP.

Name: FTP Server
Private IP: 192.168.0.30
Protocol Type: TCP
Private Port: 21

Public Port: 2100

Schedule: From: 01:00AM to 01:00AM, Sat to Sun

All Internet users who want to access this FTP Server
must connect to it from port 2100. This is an example of
port redirection and can be useful in cases where there
are many of the same servers on the LAN network.

21



Using the Configuration Menu (continued)
Advanced > Applications

R»-_I.dul&mkp AirPlus G

802.11g/2.4GHz Wireless Router
BETE Advanced JRETTE Status Help
DI-524 l
‘i-._ Special Application is used to run applications that require multiple connections.
O Enabled O Disabled
i i AN
Virtual Server Mame ‘ —
Trigger Port [ - |
Application TriggerType  [TeP v
Public Porls | |
- Public Type e
Firewall
= soy Cancel Help
—
DDNS
Mame Trigger Puhblic Port
o Batle net 12 8112 [EXT]
DMZ s
Dialpad 7175 £1200-51201,51210 [Ed]
2000-2038,2050- T
e ; !
1L 208 2051,2069,2085,3010-3030 el
VBN GaMIN 47674 2300-2400,29800-23000 E}|
PC-to-Phone 12053 12120,12122,24150-24320 Ed]
Quick Time 554 £A70-6398 B3]

Some applications require multiple connections, such as Internet gaming, video
conferencing, Internet telephony and others. These applications have difficulties working
through NAT (Network Address Translation). Special Applications makes some of these
applications work with the DI-524. If you need to run applications that require multiple
connections, specify the port normally associated with an application in the “Trigger Port”
field, select the protocol type as TCP or UDP, then enter the public ports associated
with the trigger port to open them for inbound traffic.

The DI-524 provides some predefined applications in the table on the bottom of the
web page. Select the application you want to use and enable it.

Note! Only one PC can use each Special Application tunnel.

Name: This is the name referencing the special application.

Trigger Port: This is the port used to trigger the application. It can be either
a single port or a range of ports.

Trigger Type: This is the protocol used to trigger the special application.

Public Port: This is the port number on the WAN side that will be used

to access the application. You may define a single port or a
range of ports. You can use a comma to add multiple ports or
port ranges.

Public Type: This is the protocol used for the special application.
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Using the Configuration Menu (continued)

Advanced > Filters > IP Filters

D-Link AirPlus G

802.11g/2.4GHz Wireless Router

BTN Advanced RCTTE Status Help

Filters are used to allow or deny LAN users from accessing the Internet.
@ IP Filters O URL Blocking
O MAC Filters (O Dornain Blocking

DI-524 h

Virtual Server

Lze |P Filters to deny LAN IP addresses access ta the Internet.
Application

il f

O Enabled O Disahled

Filter IP Address | || |
Part Range | I-| |
I Firewall Protocol |ﬁ|
Schedule O Always
DDNS O Fram  Time|[00 v[o0 v a0 v]joo v

day[a,ln bt tUrS_LAn R
| @ 9O

[

I Performance Apply Cancel Help
IF Range Frotocol Schedule
* TGP 20-21 always 4T
% TCP 80 always B3]

Filters are used to deny or allow LAN (Local Area Network) computers from accessing
the Internet. The DI-524 can be setup to deny internal computers by their IP or MAC
addresses. The DI-524 can also block users from accessing restricted web sites.

IP Filters: IP Filter is used to deny LAN IP addresses from accessing
the Internet. You can deny specific port numbers or all ports
for the specific IP address.

IP Address: The IP address of the LAN computer that will be denied
access to the Internet.

Port Range: The single port or port range that will be denied access to the
Internet.

Protocol Type: Select the protocol type

Schedule: This is the schedule of time when the IP Filter will be enabled.
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Using the Configuration Menu (continued)

Advanced > Filters > URL Blocking

D-Link

Buldmg Networks for People

AarPlus G

802.11g/2.4GHz Wireless Router
ST Advanced LTI Status Help
DI-524 h -

Filt;a.r.s are used to allow or deny LAN users fram accessing the Internet.
O IP Filters ® URL Blacking
O MAC Filters O Domain Blocking

Virtual Server

Bloﬁkihose LIRLz which contain kevwords listed below.
Application

il f

O Enabled @ Disabled

Filter

- Empty - [

Firewall

DDNS

@ © O

Apply Cancel Help

EH

Performance

URL Blocking is used to deny LAN computers from accessing specific web sites by the
URL. A URL is a specially formatted text string that defines a location on the Internet.
If any part of the URL contains the blocked word, the site will not be accessible and
the web page will not display. To use this feature, enter the text string to be blocked
and click Apply. The text to be blocked will appear in the list. To delete the text, just

highlight it and click Delete.

Filters- Select the filter you wish to use; in this case, URL Blocking
was chosen.

URL Blocking- Select Enabled or Disabled.

Keywords- Enter the keywords in this field. Block URLs which contain

keywords listed below.
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Using the Configuration Menu (continued)
Advanced > Filters > MAC Filters

D-Link

BulMiing Networks for People m pl [ & | Sm G

802.11g/2.4GHz Wireless Router

m Advanced R TE
DI-524 l —

O IP Filters O URL Blocking
® MAC Filters O Domain Blocking
Virtual Server

[

Application
(& Disahbled MAC Filters

Filter ) Cnlyallow computers with MAC address listed below to access the network

Filters are used to allow or deny LAN users from accessing the Internet.

Use MAC address to allow or deny computers access ta the network.

3 Onlydeny computers with MAC address listed below to access the network

Status Help

9] (Gore]

=
Name | |
- MAC Addrass I ) !
DHCP Client | -- select ane -
I DMz
I Performance

MName MAC Address

@ 9 0O

Apply Cancel Help

Use MAC (Media Access Control) Filters to allow or deny LAN (Local Area Network)
computers by their MAC addresses from accessing the Network. You can either manually
add a MAC address or select the MAC address from the list of clients that are currently

connected to the Broadband Router.

Filters- Select the filter you wish to use; in this case, MAC filters was
chosen.
MAC Filters- Choose Disable MAC filters; allow MAC addresses listed

below; or deny MAC addresses listed below.

Name- Enter the name here.

MAC Address- Enter the MAC Address.

DHCP Client- Select a DHCP client from the pull-down list; click Clone to

copy that MAC Address.
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Using the Configuration Menu (continued)

Advanced > Filters > Domain Blocking

D-Link Anr-Plus G

802.119/2.4GHz Wireless Router
B CTTNN Advanced GRS Status Help

DI-524 i

Fremmcsion |

Filters are used to allow or deny LARK users from accessing the Internet.
P Fiters (2 URL Blocking
i mac Filters & Domain Blocking

Virtual Server
& Dizsabled

lication
App & Allow users to access all domains except "Blocked Domains™.

Filter

!_ - Empty -
Firewall
e
DDNS
7 Denyusers to access all domains except "Permitted Domains”.
=
e

@ 9 O

Apply Cancel Help

Domain Blocking is used to allow or deny LAN (Local Area Network) computers from
accessing specific domains on the Internet. Domain blocking will deny all requests to
a specific domain such as http and ftp. It can also allow computers to access specific

sites and deny all other sites.

Filters- Select the filter you wish to use; in this case, Domain Block-
ing was chosen.

Domain Blocking-

Disabled- Select Disabled to disable Domain Blocking

Allows users to access all domains except Blocked Domains

Deny- Denies users access to all domains except
Permitted Domains

Blocked Domains- Enter the Blocked Domains in this field

Permitted
Domains- Enter the Permitted Domains in this field
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Using the Configuration Menu (continued)

Advanced > Firewall

D-Link ArPlus G

802.11g/2.4GHz Wireless Router
ST Advanced JRETTH Status Help
DI-524 '
i Firewall Rules can be used to allow or deny traffic from passing through the D524,
OEnabled O Disabled
—
Virtual Server hame I-—‘
Action O alow O Deny
e
\merfacel 1P Start IP End Protocol  Port Range
Source | ¥ | |
Destination [+ v| | || | e ¥ I
Schedule O Always
Firewall O Fram Time[00 {00 o o0 v]{e0 ¥]
day 30 ¥ to[ 2 ]
—
9 9O
— Apply Cancel Help
DMZ
ActionName Source Destination Protocol
Performance —
Alow Allow to Ping VAN port AN, AN ICMP.8 Ed]
Deny Default w LAN* G \__‘1‘[“
Allow Default Lan o g E{]

Firewall Rules is an advanced feature used to deny or allow traffic from passing
through the DI-524. It works in the same way as IP Filters with additional settings. You
can create more detailed access rules for the DI-524. When virtual services are created
and enabled, it will also display in Firewall Rules. Firewall Rules contain all network
firewall rules pertaining to IP (Internet Protocol).

In the Firewall Rules List at the bottom of the screen, the priorities of the rules are from
top (highest priority) to bottom (lowest priority.)

":I?;eI-JI-524 MAC Address filtering rules have precedence over the Firewall Rules.
Firewall Rules- Enable or disable the Firewall

Name- Enter the name

Action- Allow or Deny

Source- Enter the IP Address range

Destination- Enter the IP Address range; the Protocol;

and the Port Range

Schedule- Select Always or enter the Time Range.
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Using the Configuration Menu (continued)

Advanced > DDNS

D-Link AirPlus G

802.11g/2.4GHz Wireless Router
ST Advanced RETIE Status Help
DI-524 i -
Dynamic DNS
‘ » UUse Cynarmic DMS ifyau want to use yaur DDMNS accaunt,
DDNS @ Disabled O Enabled
Provider DynDMS org(Dynamic) v
Host Name | |
- Usemame | E-mail | |
Password § Key | |
@ 90
a——
Firewall Apply Cancel Help

Performance

if:

Users who have a Dynamic DDNS account may use this feature on the DI-524.

Provider- Select from the list of DDNS servers available.
Host Name- Enter your DDNS account host name.
Username/Email- Enter your DDNS account username.
Password/Key- Enter your DDNS account password.
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Using the Configuration Menu (continued)

Advanced > DMZ

D-Link

Firewall

DDNS

Bulkimg Networks for Peopie ﬂ plus G
802.11g/2.4GHz Wireless Router
| Home WUEIITTR Tools  Status Help
DI-524 h m—
bM;Z(DemiIitarized Zone) is used to allow a single computer on the LAN to be exposed to
v the Internet.
ey OEnabled @ Disabled
Virtual Server —
IP Address 182.168.0/ |
= Q00
=l
oons |

DMz

I Performance

If you have a client PC that cannot run Internet applications properly from behind the DI-
524, then you can set the client up for unrestricted Internet access. It allows a computer
to be exposed to the Internet. This feature is useful for gaming purposes. Enter the IP
address of the internal computer that will be the DMZ host. Adding a client to the DMZ
(Demilitarized Zone) may expose your local network to a variety of security risks, so

only use this option as a last resort.

DMZ- Enable or Disable the DMZ. The DMZ (Demilitarized Zone)
allows a single computer to be exposed to the internet. By
default the DMZ is disabled.

IP Address- Enter the IP Address of the computer to be in the DMZ
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Using the Configuration Menu (continued)
Advanced > Performance

DI-524 [

“ . :
o
o
O
o
—

Virtual Server
Application
iiter

Firewall

DDNS

bmz

Performance

Beacon Interval-

RTS Threshold-

Fragmentation-

DTIM Interval-

Wireless Mode-

TX Rates-
SSID Broadcast-

D-Link

BulKImg Networks for People

AirPlus G

802.11g/2.4GHz Wireless Router
| Home W UZTTITH Tools Status Help
These are the Wireless Performance features for the AP{Access Paint partion
Beacon Interval 1“00 Hmsen‘ range:1 ~1000, default: 100)
RTS Threshald ‘2432 ‘(range 256~2432, default 2432)
Fragmentation [235 | (range: 2562346, default: 2348, even number anky)
DTIM Interval ‘3 ‘(range 1~65535, default 3)
Wireless Mode @ mixed mode O G mode
TX Rates [aute % Japs)
Authentication Type (O Open System O Shared Key @ Both
551D broadcast @ Enable O Disable
Apply Cancel Help

Beacons are packets sent by an Access Point to synchronize
a wireless network. Specify a value. 100 is the default setting
and is recommended.

This value should remain at its default setting of 2432. If incon-
sistent data flow is a problem, only a minor modification should
be made.

The fragmentation threshold, which is specified in bytes, deter-
mines whether packets will be fragmented. Packets exceeding
the 2346 byte setting will be fragmented before transmis-
sion.2346 is the default setting

(Delivery Traffic Indication Message) 3 is the default setting. A
DTIM is a countdown informing clients of the next window for
listening to broadcast and multicast messages.

Select Short or Long Preamble. The Preamble defines the
length of the CRC block (Cyclic Redundancy Check is a com-
mon technique for detecting data transmission errors) for
communication between the wireless router and the roaming
wireless network adapters. Note: High network traffic areas
should use the shorter preamble type.

Auto is the default selection. Selct from the drop down menu.
Choose Enabled to broadcast the SSID across the network.
All devices on a network must share the same SSID (Service

Set Identifier) to establish communication. Choose Disabled
if you do not wish to broadcast the SSID over the network.
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Using the Configuration Menu (continued)

Tools> Admin

D-Link

Bulkimg Networks for Peaple

AirPlus G

802.11g/2.4GHz Wireless Router
Home Advanced i ( 1.115 Status Help
DI-524 l

Administrators can change their login password

Administrator (The Login Name is "admin®)

New Password kesseees
Admin [abeihde i
Reconfirm Password [sessewes

Tis
e User (The Login name is "uger’)

Mew Paaswnrdi ........
System
Reconfirm Password |sesseses

Firmware
Let administrator perform administration task from remote host

il

Misc
O Enabled @ Disabled

IP Address (1000 |

Port|g080 |

@ 9 0

Apply Cancel Help

At this page, the DI-524 administrator can change the system password. There are two
accounts that can access the Broadband Router’s Web-Management interface. They
are admin and user. Admin has read/write access while user has read-only access.
User can only view the settings but cannot make any changes.

Administrator- admin is the Administrator login name
Password- Enter the password and enter again to confirm
User- user is the User login name

Password- Enter the password and enter again to confirm

Remote Management- Remote management allows the DI-524 to be configured
from the Internet by a web browser. A username and password is still required to ac-
cess the Web-Management interface. In general, only a member of your network can
browse the built-in web pages to perform Administrator tasks. This feature enables
you to perform Administrator tasks from the remote (Internet) host.

IP Address- The Internet IP address of the computer that has access to the Broad-
band Router. If you input an asterisk (*) into this field, then any computer will be able
to access the Router. Putting an asterisk (*) into this field would present a security risk
and is not recommended.

Port- The port number used to access the Broadband Router.
Example- http://x.x.x.x:8080 where x.x.x.x is the WAN IP address of the Broadband
Router and 8080 is the port used for the Web-Mangement interface.
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Using the Configuration Menu (continued)

Default
NTP Server-

Time Zone-

Set the Time-

Daylight
Saving-

Tools > Time

D-Link

Bulnmg Networks for People

AirPlus G

802.11g/2.4GHz Wireless Router

Home Advanced (711 Status Help

Setthe DF524 systern time
Device Time : Fri Aug 13 03:07:48 2004

& Enable NTP
Default NTP Server

DI-524 h

Admin

[optanal

Time Zone
Time | (GMT-08:00Pacific Tim (US & Canads) v |

() SetDevice Date and Time
| p—— | 1
ear (2004 ¥ ont [ 443 %] pay[13 ]

Firmware Haur. |Egl\ Mmute:@j Second. LQUA

System

i

Daylight Saving
OEnable ® Disable
Start| Jan v ;'517\" End | Jan V| [70717\"

Misc

[

9 90

Apply Cancel Help

NTP is short for Network Time Protocol. NTP synchronizes
computer clock times in a network of computers.
This field is optional.

Set Device Date and Time: To manually input the time. Enter
the values in these fields for the Year, Month, Day, Hour,
Minute, and Second.

To manually input the time, enter the values in these fields for the
Year, Month, Day, Hour, Minute, and Second. Click Set Time.

To select Daylight Saving time manually, select enabled or
disabled, and enter a start date and an end date for daylight
saving time.
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Using the Configuration Menu (continued)

Tools > System

D-Link AirPlus G

802.11g/2.4GHz Wireless Router

' Home Advanced R (7[J Status  Help
e ||

Save Seftings To Local Hard Drive

Backup Setting

Load Settings From Local Hard Drive

| )
=

System Restore To Factory Default Settings
I Firmware

_ L+

The current system settings can be saved as a file onto the local hard drive. The saved
file or any other saved setting file can be loaded back on the Broadband Router. To
reload a system settings file, click on Browse to browse the local hard drive and locate
the system file to be used. You may also reset the Broadband Router back to factory
settings by clicking on Restore.

Save Settings to
Local Hard Drive- Click Save to save the current settings to the local Hard Drive

Load Settings from
Local Hard Drive- Click Browse to find the settings, then click Load

Restore to Factory
Default Settings-  Click Restore to restore the factory default settings
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Using the Configuration Menu (continued)

Tools > Firmware

D-Link AirPlus G

802.11g/2.4GHz Wireless Router

G CUELEL] Tools Status Help
DI-524 D _
‘;ﬁ,’;—) There may he new firmware faryour D524 to imprave functionality and performance.
The upgrade procedure takes about 20 seconds. Motel Do not power off the unitwhen itis

being upgraded. When the upgrade is done successfully, the unitwill be restarted

I Admin automatically.
Current Firmware Version: V1.00

| Time Firmware Date: Mon, Oct 4 2004

' -
9 © 0

Apply Cancel Help

You can upgrade the firmware of the Router here. Make sure the firmware you want
to use is on the local hard drive of the computer. Click on Browse to browse the local
hard drive and locate the firmware to be used for the update. Please check the D-Link
support site for firmware updates at http://support.dlink.com. You can download firmware
upgrades to your hard drive from the D-Link support site.

Firmware Upgrade- Click on the link in this screen to find out if there is an up-
dated firmware; if so, download the new firmware to your hard

Browse- After you have downloaded the new firmware, click Browse in

this window to locate the firmware update on your hard drive.
Click Apply to complete the firmware upgrade.
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Using the Configuration Menu (continued)

Ping Test-

Restart
Device-

Block
WAN
Ping-

UPNP-

VPN
Pass
Through-

Tools > Misc
D-Link

BuibIng Networks o1 Peopie

AirPlus G

802.11g/2.4GHz Wireless Router

Home  Advanced Tools Status Help
DI-524 ]
Ping Testis used to send "Ping" packets to testif a computer is on the Internet.
Host Mame or IF address | (g

T —
Admin t
Reboots the DI-524

I0f

. Reboot

System B

When you "Black WAN Ping", you are causing the public WiAN IP address an the D424 to not
respond to ping commands. Pinging public YWAN IF addresses is a commaon method used by
hackers to testwhether your WAl IP address is walid

[i

Firmware

Discard FING fram WAN side () Enabled & Disabled
Misc

*ou can setup this item if you want to enable 5Pl mode

O Enabled & Disabled

*ou can disable or enable UPnP functions at anytime
® Enabled O Disabled

Allows YPM connections to work through the DI-524.

The Ping Test is used to send Ping packets to test if a computer is on the
Internet. Enter the IP Address that you wish to Ping, and click Ping

Click Reboot to restart the DI-524

If you choose to block WAN Ping, the WAN IP Address of the DI-524
will not respond to pings. Blocking the Ping may provide some extra
security from hackers.

Discard Ping from WAN side-

Click Enabled to block the WAN ping

To use the Universal Plug and Play feature click on Enabled. UPNP pro-
vides compatibility with networking equipment, software and peripherals
of the over 400 vendors that cooperate in the Plug and Play forum.

The DI-524 supports VPN (Virtual Private Network) pass-through for
both PPTP (Point-to-Point Tunneling Protocol) and IPSec (IP Security).
Once VPN pass-through is enabled, there is no need to open up virtual
services. Multiple VPN connections can be made through the DI-524.
This is useful when you have many VPN clients on the LAN network.

PPTP- select Enabled or Disabled
IPSec- select Enabled or Disabled
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Using the Configuration Menu (continued)

Status > Device Info

D-Link

BUIKImg NETWorks 1or People

AirPlus G
802.11g/2.4GHz Wireless Router

Home Advanced Tools Status m

Firmwar e Version: V1.00, Mon, Oct 4 2004

DI-524 l

LAN

MAC Address 00-50-18-21-B7-54
Device Info IP Address 192.168.0.1
Subnet Mask 255.255.255.0

DHCP Server Enabled
Log

Stets MAC Address 00-50-18-21-B7-53

I _ PPPoE Disconnected
Wireless Connect Dizconnect
IP Address 0.0.0.0
Connection Time -
Subnet Mask 0.0.0.0
Gateway 0.0.0.0
Domain Name Server 0.0.0.0

ilil

Wireless
MAC Address 00-50-18-21-B7-54
ESSID default
Security Mone
Channel &

This page displays the current information for the DI-524. It will display the LAN, WAN
and MAC address information.

If your WAN connection is set up for a Dynamic IP address then a Release button
and a Renew button will be displayed. Use Release to disconnect from your ISP and
use Renew to connect to your ISP.

If your WAN connection is set up for PPPoE, a Connect button and a Disconnect but-
ton will be displayed. Use Disconnect to drop the PPPoE connection and use Connect
to establish the PPPoE connection.

This window will show the DI-524’s working status:

WAN

LAN

Wireless

IP Address: WAN/Public IP Address

Subnet Mask: WAN/Public Subnet Mask

Gateway: WAN/Public Gateway IP Address

Domain Name Server: WAN/Public DNS IP Address
WAN Status: WAN Connection Status

IP Address: LAN/Private IP Address of the DI-524
Subnet Mask: LAN/Private Subnet Mask of the DI-524

MAC Address: Displays the MAC address

SSID: Displays the current SSID

Channel: Displays the current channel

WEP: indicates whether WEP is enabled or disabled
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Using the Configuration Menu (continued)

Status > Log

D-Link AirPlus G

802.11g/2.4GHz Wireless Router

- Home Advanced Tools Status m
DI-524 l
c view Log displays the activities accurting on the DI-524. Click on Log Seftings far advance
v features.
T deee o - o
Help
Page 1/68

Log
WiAN Type: PPP over Ethernet &W1.00)
Displaytime: Fri Aug 13 03:31:02 2004
Stats
20045 8H138 £F 03:00:48 DOD:triggered internally
2004585138 L4F 03:00:49 PPPOE start to dial-up
20045 8H138 L 03:00:43 PADI sent
2004588138 £ 03:00:49 PADI sent
20045 8H 138 £F 03:00:50 PADI sent
2004588138 £F 03:00:53 DODtriggered internally
2004588138 LF 03:00:53 PFPOE start to dial-up
2004588138 L 03:00:53 PADL:3com sent
2004588138 £F 03:00:53 PADI:3com sent
2004588138 L£F 03:00:54 PADI3com sent

i

The Broadband Router keeps a running log of events and activities occurring on the
Router. If the device is rebooted, the logs are automatically cleared. You may save the
log files under Log Settings.

View Log- First Page - The first page of the log
Last Page - The last page of the log
Previous - Moves back one log page
Next - Moves forward one log page
Clear - Clears the logs completely
Log Settings - Brings up the page to configure the log
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Using the Configuration Menu (continued)

Status > Log > Log Settings

D-Link AirPlus G
802.11g/2.4GHz Wireless Router

" Home Advanced Tools Status m

Log Settings
Logs can be saved by sending itto an admin email address orto a syslog server.

DI-524 i
E-mail Alert

SMTP Server/ IP Address | |
|[_send Mail Now

i {

Device Info
Email Address |

E-mail Subject |

Log
Syslog
| Stats Syslog Semver IP Address 192 168.0, () Enabled & Disabled
Log Type [F] System Activity

e [¥] Debug Infarmation
Wireless & .
[¥] Attacks

Dropped Packets
M Motice

9 90

Apply Cancel Help

Not only does the Broadband Router display the logs of activities and events, it can
setup to send these logs to another location.

SMTP Server/
IP Address - The address of the SMTP server that will be used to send the logs

Email Address - The email address to which the logs will be sent.

Click on Send Mail Now to send the email.
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Using the Configuration Menu (continued)
Status > Stats

D-Link

Bulwdmg Networks for People

Air-Plus G
802.11g/2.4GHz Wireless Router

Home Advanced Tools Status m

DI-524 i
‘.- Traffic Statistics display Receive and Transmit packets passing through the DI-524.
P o
Device Info
Help
P
Log ; ;
Receive Transmit
WAN 0 Packets 2037 Packets
LAN 4091 Packets 3509 Packets
Stats Wireless 0 Packets 2037 Packets

|

The screen above displays theTraffic Statistics. Here you can view the amount of
packets that pass through the DI-524 on both the WAN and the LAN ports. The traffic
counter will reset if the device is rebooted.

Status > Wireless

D-Link

Bulking Networks for People

AirPlus G

802.11g/2.4GHz Wireless Router

. Home Advanced Tools status G

DI-524 i —

The.WireIéss Clienttable below-displays Wireless clients Connected to the AP {Access Foint).

Device Info o

Help

i f

Log
Connected Time MAC Address

I Stats

Wireless

The wireless client table displays a list of current connected wireless clients. This
table also displays the connection time and MAC address of the connected wireless
client.

Click on Help at any time, for more information. 39



Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.

Note: Please refer to websites such as http://www.homenethelp.com

and http://www.microsoft.com/windows2000 for information about networking
computers using Windows 2000, ME or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Hatwrork Setup Wizord

Wielvorne Lo Lhae M Lvrore Selup
Wizard

Thz ~irond Ailk= pyrasclon sk cemeLher s hns waore
azhwrk, ety rocil pod oo

* Lezme 3 Inberazl conmechiar

w Sl clerm Zorresen Foeel
= o b Lhdaw

=t iz

T ol e, v pes Hesl,

When this screen appears, Click Next.
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Networking Basics

Please follow all the instructions in this window:

FHehenrk: Setup Wizard

Defore mou Codinues. .

Tamr, eoerl== e i e ey

= ree=lbe v o med = e, mee w=Flee

= Twnw ol =ema dees pinesez oo eeecinal mod = e
= Crraeesor lhe aliict

" 5B b B vimoed el s beea R rlemes conension v waoneeherl

| < Ulack ' Tl e |m| _mazal |

Click Next

In the following window, select the best description of your computer. If your computer
connects to the internet through a gateway/router, select the second option as shown.

Metwsork Setup ¥izand

Eedecl a vowmmectiom mnethod.

= Ll ldzmn Ll A el e Dy cowocomn e

7 Thi Zorpuier czpnzoe: dictie o ke sieeot The athe compaions on my acisors comnos
Lo e o bl e iz comand
e g suEmcke

O T T A e S e AL RSP e
AssdRtlEl A i

“rlt'\u"‘ a :H:III_;:I

.3 Lk

-ea roe zbovkbome o sma | Sllize nehwork conig ol ong.

s =k et Femel

Click Next
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Networking Basics

Enter a Computer description and a Computer name (optional.)

Click Next

bk 3w luy Wicard

[ive thia mampatea A deamiplion and soame

(:JIII.".-'M Sl Mary's Compubar )
Ewamiplaz = anide B n Zomonbe ke Ziesdls G e

(_.Jm'll.lﬂ' B ] )
Furmrl= SRR T er R AT

Tar ety coCpircracmT is Offips

—COF7 WG Q20U SOCDUer Mo s ard Jossiialios:

5 Bazk l ot l Zzrea |

Enter a Workgroup name. All computers on your network should have the same
Workgroup name.

Click Next

(SRR T T L TR TR

Mamnr prar nedwnrk

Bz wavrrizlvsib, v cp b e g e g ridmz Lo, o] s petoe oo sy rate b,
Pzl Pawe ke remm vici gioup rarme

i B R R Lmaa. nimgy
—oorcpl-s HO=s =1 OFF 2=

< Nla-k H=at [ TArre ]
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Networking Basics

Please wait while the Network Setup Wizard applies the changes.

mMefwnek Sl Wizard

Fombky v apply iulvwamk swllings.. .

b omza _ovad Aol e Clovareg e nngss |y pios=sms men 2k = e mrnaey o copede
A1 Caarok e i hemusied

Siod:rgs:

M-k, ey
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When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.
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Networking Basics

In the window below, select the option that fits your needs. In this example, Create
a Network Setup Disk has been selected. You will run this disk on each of the
computers on your network. Click Next.

Melwurls Sclup ¥hzand

¥ruu're: nlmnsl dane

B ounzed oo e Meems < Seduo W] oo ez ol The oo oz Cnge
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T _lae e bemteimik feenp sk =lesack baes
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Insert a disk into the Floppy Disk Drive, in this case drive A.
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Lor—m: s

Click Next.
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Copying...

~ i -

Please wait wkile tie wizard copies files. ..

) Canz |

Please read the information under Here’s how in the screen below. After you complete
the Network Setup Wizard you will use the Network Setup Disk to run the Network

Setup Wizard once on each of the computers on your network. To continue click Next.

Metwrk Setup Wizand

Ta run te mizard with the Malwork Setup Disk .
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Networking Basics

Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.

Heteonk Sedup Yhzard

Completing rhe MNetwork Setup
Wirand
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The new settings will take effect when you restart the computer. Click Yes to restart
the computer.
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You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network

Setup Disk on all your computers, your new wireless network will be ready to use.
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Networking Basics
Naming your Computer

To name your computer, please follow these directions:In Windows XP:

B Click Start (in the lower left corner of the screen)
m Right-click on My Computer

W Select Properties and click

IntErnat J My Documents
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5
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Name Tab in the System £y viem H
Properties window. | Geneel

bz Lpoates Hemale
Hardmare || Advaiced
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B You may enter a
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B To rename the computer
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Change.
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Networking Basics
Naming your Computer

M |n this window, enter the
Computer name

B Select Workgroup and enter
the name of the Workgroup

B All computers on your

network must have the same

Workgroup name.

B Click OK

Compirter Name Chanpes

YYau can changz the name and the merrbershia of this
computsr Charges may sffec: access bo nework esourses,

LCampuber name
Oifice

Fall camputsr name
Office

I More..

W embe: cf

() Deenaine

& workgoun

Acrounting

]

Checking the IP Address in Windows XP

The wireless adapter-equipped computers in your network must be in the same IP Ad-
dress range (see Getting Started in this manual for a definition of IP Address Range.)

To check on the IP Address of the

adapter, please do the following:

B Right-click on
the Local Area
Connection icon

in the task bar

B Click on Status

Dizahle

Repair
Wiew Available Wirelzss Metworks

Cpen Merwiork Connections
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Networking Basics
Checking the IP Address in Windows XP

This window will appear. Wireless Network

2]

Connection 7 Status z|

. General ‘ Support '
. Interret Pratocal [TCRAAF)
[ | Click the
Support tab Address Type: Azzigned by DHCP
[ IP Address: 192.168.0.114 ]
Subret Mask: 255 255, 255.0
Default Gatewaw: 192 168.01
[ | Click Close

Assigning a Static IP Address in Windows

XP/2000

Note: Residential Gateways/Broadband Routers will automatically assign IP Addresses
to the computers on the network, using DHCP (Dynamic Host Configuration Protocol)
technology. If you are using a DHCP-capable Gateway/Router you will not need to

assign Static IP Addresses.

If you are not using a DHCP capable Gateway/Router,
IP Address, please follow these instructions:

or you need to assign a Static

@ Tour ‘Windows xP
1‘{-! Paink
=
w Fles and Settings Trarsfer
wizard

All Programs P

Go to Start

Double-click on
Control Panel

‘ l' _ontrol Fanel

Hé Printers ard Faxes

_t_‘/l Help a7d Support
I:J Search

I J mun..

ﬁ| Lug 2T rm | Turi S Cunpuler




Networking Basics
Assigning a Static IP Address in Windows XP/2000

B Conlrol Punel
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Networking Basics
Assigning a Static IP Address
in Windows XP/2000

B Click on Internet Protocol
(TCP/IP)

Click Properties

Input your IP address and
subnet mask. (The IP
Addresses on your network
must be within the same
range. For example, if

one computer has an IP
Address of 192.168.0.2,
the other computers should

_ Local Area Connection 2 I'roportics

Gewerd | Advaxed

Carmec: Liing

BBl DuLink DWL-8652
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[ XE

[ nx

have IP Addresses that are
sequential, like 192.168.0.3
and 192.168.0.4. The subnet
mask must be the same for
all the computers on the
network.)

Input your DNS server
addresses. (Note: If you
are entering a DNS server,
you must enter the IP
Address of the Default
Gateway.)

The DNS server information will be supplied
by your ISP (Internet Service Provider.)

B Click OK

Internet Profaenl | IE4R) Honperdies

EECR]
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Networking Basics

Assigning a Static IP Address with Macintosh OSX

B Gotothe Apple Menu and select

System Preferences

B Click on Network

B Select Built-in Ethernetin the
Show pull-down menu

m Select Manually in the
Configure pull-down menu

B Inputthe Static IP Address,
the Subnet Mask and the
Router IP Address in the
appropriate fields

Bl Click Apply Now
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Networking Basics

Selecting a Dynamic IP Address with Macintosh OSX

B  Go to the Apple Menu and select

System Preferences

Click on Network

Select Built-in Ethernet in the
Show pull-down menu

Select Using DHCP in the
Configure pull-down menu

B Click Apply Now

B The IP Address, Subnet
mask, and the Router’s IP
Address will appear in a few
seconds
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Networking Basics
Checking the Wireless Connection by Pinging in Windows XP and

2000

m Go to Start > Run >
type cmd. Awindow &
similar to this one
will appear. Type
ping XXX.XXX.XXX.
XXX, where xxx is
the IP Address of :
the Wireless Router IR E INEESENITTRITers
or Access Point.

A good wireless
connection will show
four replies from

the Wireless Router
or Acess Point, as
shown.

Checking the Wireless Connection by Pinging in Windows Me
and 98

B Go to Start > Run
> type command.
A window similar
to this will appear.
Type ping XXX.XXX.
XXX.XXX where xxx
is the IP Address
of the Wireless
Router or Access
Point. A good
wireless connection
will show four
replies from the
wireless router or
access point, as
shown.
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DI-524 Wireless Broadband Router. We cover various aspects of the
network setup, including the network adapters. Please read the following if you are
having problems.

Note: It is recommended that you use an Ethernet connection to
configure the DI-524 Wireless Broadband Router.

1.The computer used to configure the DI-524 cannot access the
Configuration menu.

B Check that the Ethernet LED on the DI-524 is ON. If the LED is not
ON, check that the cable for the Ethernet connection is securely

inserted.

B Check that the Ethernet Adapter is working properly. Please see
item 3 (Check that the drivers for the network adapters are
installed properly) in this Troubleshooting section to check that

the drivers are loaded properly.

B Check that the IP Address is in the same range and subnet as the
DI-524. Please see Checking the IP Address in Windows XP in

the Networking Basics section of this manual.

Note: The IP Address of the DI-524 is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.
Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

m Do aPing test to make sure that the DI-524 is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.1. A successful

ping will show four replies.

Note: If you have
changed the default IP
Address, make sure to
ping the correct IP Ad-
dress assigned to the
DI-524.
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Troubleshooting
2. The wireless client cannot access the Internet in the

Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection
icon in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

correct available network, as shown in the illustrations below.

Connect to Wireless Network @@

Disahle The following network(z) are available, To access a network, select
it from the list, and then click Connect.
Status

Repair Available network.s:

i alan ~

E dan

i nn

et

If you are having difficulty connecting to a network, click Advanced.

[ Corinect l[ Cancel ]

B Check that the IP Address assigned to the wireless adapter is within
the same IP Address range as the access point and gateway. (Since
the DI-524 has an IP Address of 192.168.0.1, wireless adapters must
have an IP Address in the same range, e.g., 192.168.0.x. Each device
must have a unique IP Address; no two devices may have the same IP
Address. The subnet mask must be the same for all the computers on
the network.) To check the IP Address assigned to the wireless adapter,
double-click on the Local Area Connection icon in the taskbar >
select the Support tab and the IP Address will be displayed. (Please
refer to Checking the IP Address in the Networking Basics section of
this manual.)

B [fitis necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you
are entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable router,
you will not need to assign a Static IP Address. See Networking

Basics: Assigning a Static IP Address.)
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Troubleshooting

3. Check that the drivers for the network adapters are

installed properly.

You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are

using.

m Go to Start >
My Computer >
Properties

B Selectthe
Hardware
Tab

B Click Device
Manager
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Troubleshooting

Double-click
on Network
Adapters

Right-click on D-Link
AirPlus DWL-G650
Wireless Cardbus
Adapter (In this example
we use the DWL-G650;
you may be using other
network adapters, but
the procedure will remain
the same.)

Select Proper-
ties to check that
the drivers are
installed properly

Look under Device
Status to check that the
device is working

properly

Click OK
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Troubleshooting

4. What variables may cause my wireless products
to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this
manual for further information about the most advantageous placement of your D-Link
wireless products.

5. Why does my wireless connection keep dropping?

B Antenna Orientation- Try different antenna orientations for the DI-524. Try to
keep the antenna at least 6 inches away from the wall or other objects.

W If you are using 2.4GHz cordless phones, X-10 equipment or other home
security systems, ceiling fans, and lights, your wireless connection will degrade
dramatically or drop altogether. Try changing the Channel on your Router, Access
Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

If you have enabled Encryption on the DI-524, you must also enable encryption on all
wireless clients in order to establish a wireless connection.

B For 802.11b, the Encryption settings are: 64, 128, or 256 bit. Make sure that
the encryption bit level is the same on the Router and the Wireless Client.

B Make sure that the SSID on the Router and the Wireless Client are exactly the
same. If they are not, wireless connection will not be established.

B Move the DI-524 and the wireless client into the same room and then test the
wireless connection.

B Disable all security settings. (WEP, MAC Address Control)

59



Troubleshooting

6. Why can’t | get a wireless connection? (continued)

Turn off your DI-524 and the client. Turn the DI-524 back on again, and then
turn on the client.

Make sure that all devices are set to Infrastructure mode.

Check that the LED indicators are indicating normal activity. If not, check that
the AC power and Ethernet cables are firmly connected.

Check that the IP Address, subnet mask, gateway and DNS settings are cor-
rectly entered for the network.

If you are using 2.4GHz cordless phones, X-10 equipment or other home se-
curity systems, ceiling fans, and lights, your wireless connection will degrade
dramatically or drop altogether. Try changing the Channel on your DI-524, and
on all the devices in your network to avoid interference.

Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

7. | forgot my encryption key.

Reset the DI-524 to its factory default settings and restore the other devices on
your network to their default settings. You may do this by pressing the Reset

button on the back of the unit. You will lose the current configuration settings.
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Troubleshooting

8. Resetting the DI-524 to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may
choose to Reset the DI-524 to the factory default settings. Remember that
D-Link AirPro products network together, out of the box, at the factory default
settings.

Reset

To hard-reset the DI-524 to Factory Default Settings, please do the following:

B | ocate the Reset button on the back of the DI-524
B Use a paper clip to press the Reset button

B Hold for about 10 seconds and then release

m After the DI-524 reboots (this may take a few minutes)
it will be reset to the factory Default settings
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Technical Specifications

Standards
m |EEE 802.119g
B |EEE 802.11b
m |EEE 802.3
m |EEE 802.3u

VPN Pass Through/ Multi-Sessions
m PPTP
B L2TP
m [PSec

Device Management

B Web-Based- Internet Explorer v6 or later; Netscape Navigator v7
or later; or other Java-enabled browsers

B DHCP Server and Client

Advanced Firewall Features

m NAT with VPN Passthrough (Network Address Translation)
MAC Filtering
IP Filtering
URL Filtering
Domain Blocking
Scheduling
Wireless Operating Range
B Indoors — up to 328 feet (100 meters)
m Outdoors — up to 984 feet (300 meters)
Operating Temperature
B 32°F to 131°F (0°C to 55°C)

Humidity:
B 95% maximum (non-condensing)

Safety and Emissions:
m FCC,CE

Wireless Frequency Range:
B 2.4GHzto 2.462GHz
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Technical Specifications

LEDs:

Power

WAN

LAN (10/100)

WLAN (Wireless Connection)

Physical Dimensions:

m L=5.6inches (142mm)
m W =43 inches (109mm)
m H=1.2inches (31mm)

Wireless Transmit Power:
m 14dBm

Security:

m 802.1x

m WEP
WPA
WPA-PSK

External Antenna Type:
B Single detachable reverse SMA

Modulation Technology:
m Orthogonal Frequency Division Multiplexing (OFDM)

Power Input:
B Ext. Power Supply DC 7.5V, 1.5A

Weight:
m 0.44 Ibs. (2009)
Warranty:

m 1year
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Technical Specifications

Wireless Data Rates with Automatic Fallback:

54 Mbps
48 Mbps
36 Mbps
24 Mbps
18 Mbps
12 Mbps
11 Mbps
9 Mbps
6 Mbps
5.5 Mbps
2 Mbps
1 Mbps

Receiver Sensitivity:

54Mbps OFDM, 10% PER, -68dBm
48Mbps OFDM, 10% PER, -68dBm
36Mbps OFDM, 10% PER, -75dBm
24Mbps OFDM, 10% PER, -79dBm
18Mbps OFDM, 10% PER, -82dBm
12Mbps OFDM, 10% PER, -84dBm
11Mbps CCK, 8% PER, -82dBm
9Mbps OFDM, 10% PER, -87dBm
6Mbps OFDM, 10% PER, -88dBm
5.5Mbps CCK, 8% PER, -85dBm
2Mbps QPSK, 8% PER, -86dBm
1Mbps BPSK, 8% PER, -89dBm

64



Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-524 (192.168.0.1), you are not connecting to
the Internet or have to be connected to the Internet. The device has the utility built-in
to a ROM chip in the device itself. Your computer must be on the same IP subnet to
connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device.
If you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/’XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What's the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two
types of cable have different purposes

for different LAN configurations. EIA/TIA

568A/568B define the wiring standards 3 hite-Green
and allow for two different wiring color g ‘-B’*:ﬂge-manﬂe
codes as illustrated in the following 5 White-Blue
diagram_' . g gmi':g-%mwn
*The wires with colored backgrounds may 8 Brown
have white stripes and may be denoted 5684 CABLE END
that way in diagrams found elsewhere. .

1 White-Orange
How to tell straight-through cable from g g;i't‘g_%men
a crossover cable: 4 Blue
The main way to tell the difference 2 Whito Blue
between the two cable types is to ; Es:gitfn-ﬁmwn

compare the wiring order on the ends
of the cable. If the wiring is the same on 3686 CABLE END

both sides, it is straight-through cable. If one side has opposite wiring, it is a
crossover cable.

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable

is important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover

Hub/Switch uplink port to another Hub/Switch normal port - Straight-through 66



Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any Internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Step 3 Configure your Internet settings.

Go to Start>Settings>Control Panel. Double
click the Internet Options Icon. From the Security
tab, click the button to restore the settings to their
defaults.

Click to the Connection tab and set the dial-
up option to Never Dial a Connection. Click

the LAN Settings button

Nothing should be checked. Click OK

Go to the Advanced tab and click the
button to restore these settings to their

defaults

Click OK. Go to the desktop and close any open
windows
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the
same range of the device you are attempting to configure. Most D-Link devices use
the 192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as
shown then click OK.

Run

Tupe the name of a prograrn, falder, or document, and
Windows will open it for pau.

Open: |winipcfg j

0k i Cancel | Browse... |

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

B Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

m IP Configuration [_ [C]x]

i Ethernet Adapter Information

EEE
Adapter Addiess [0y

IP Address 0.0.00
Subnet Mask 0.0.0.0
Default G ateway

ak I Heleaze, | Hemew |

Release Al | Renew Al | HMore Info => |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.

Step 5 Click OK to close the IP Configuration window
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.
Step 2 Type cmd then click OK.

Run liJ o

= Twpe the name of a program, Folder, document, or
- Internet resource, and Windows will open it Faor you,

Qpen: [ cmd w

[ K H Cancel H Browse, .. J

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway

S WINNT system32' CMD.EXE

rosoft Windows 2088 [Uersion 5. 21951
(C) Copyllght 1985-288@ Microsoft Corp.

D:“\>ipconfig

Windows 2888 IF Configuration

Ethernet adapter Local Area Connection:
Connection—specific DNS Suffix

IP AAAress. » » - « = - « o = « . = 192.168.0.174
Subnet Mask = 255.255.255.8

Default Gateway : 122.168.8.1

Step 4 Type exit to close the command prompt.
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP
Address in the same range of the device you are attempting to configure. Most D-
Link devices use the 192.168.0.X range.

Make sure you take note of your computer’s Default Gateway IP Address. The
Default Gateway is the IP Address of the D-Link router. By default, it should be

192.168.0.1.

How can | assign a Static IP Address in Windows XP?

Step 1
Click on Start > Control Panel > Network and Internet Connections >

Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.
How can | assign a Static IP Address in Windows 20007?

Step 1 Right-click on My Network I

Places and select Properties. g o QIS Xl
vy U EC IS

Step 2 Right-click on the Local Network and Dislup - <o

Area Connection which represents P

your network card and select —

Properties. e

21

Connect using

I E§ D-Link DFE-530TX PCl Fast Ethernet Adapter

Highlight Internet Protocol (TCP/
IP) and click Properties.

Install Uninstall | Piopeties |

~Desciption
Transs

ntrol Pratocal/ntemet Protocal. The default
ovi urication

wide 3 i prol
acrass diverse intercornected netwark:

[¥ Shaw icon in taskbar when connected

oK Cancel
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows

20007 (continued)

Click Use the following IP Address and
enter an IP Address that is on the same
subnet as the LAN IP Address on your
router. Example: If the router’s LAN IP
Address is 192.168.0.1, make your IP
Address 192.168.0.X where X = 2-99.
Make sure that the number you choose
is not in use on the network.

G

Set the Default Gateway to be the
same as the LAN IP Address of your
router (192.168.0.1).

Internet Protocol {TCP/IP) Properties:

2lx|
eneral

“You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask pour network administrator for
the appiopriate P setlings.

" Dbtain an IP address automatically

192 .168. 0 . ES
285.295.255. 0
192.168. 0 .1

& [btain DNS server address automatically

(% Lize the following IP address:
1P address:
Subnet mask.

Default gateway:

% Usg the follawing DNS server addresses:

192.188. 0 .1

4 .2 .2 .2

Advanced..

Ereferred DNS server:

Alternate DNS server.

Set the Primary DNS to be the same

Cancel

as the LAN IP address of your router
(192.168.0.1).

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want
Yes.

How can | assign a Static IP
Address in Windows 98/Me?

Step 1 From the desktop, right-click on the
Network Neigborhood icon (Win ME - My

Network Places) and select Properties

Highlight TCP/IP and click the Properties
button. If you have more than 1 adapter,
then there will be a TCP/IP “Binding”

for each adapter. Highlight TCP/IP >
(your network adapter) and then click

Properties.

to reboot your computer. Click

Network
Configuraton | denificstion | Access Cortrol|

The following network components are installed

Client for Micrasoft Metwarks
D-Link DFE-530T% PCI Fast Ethernet Adapter (Rev &)

Add

Remave Propetties

PFrimary Network Logon

[l tor Microsof Networks |
File and Print Sharing
Desciption
TCPAIR is the protocal you use ta cannect ta the Intemet and
widerarea netuiorks:
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in
Windows 98/Me? (continued)

(1P Propenies G |

Step 2 Click Specify an IP Address. =

Enter in an IP Address that is on the same ﬁ*'mmmmmmy

subnet as the LAN IP Address on your

router. Example: If the router’s LAN IP e

Address is 192.168.0.1, make your IP 1P Adsess

Address 192.168.0.X where X is between Subem ok (755755 755 1

2-99. Make sure that the number you choose

is not in use on the network.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router T
here (192.168.0.1). "jf“j‘"“_°"‘"“""‘“’°'“°""jj"f"
Click Add when finished. o
o
Step 4 Click on the DNS Configuration tab. — =

Click Enable DNS. Type in a Host (can
be any word). Under DNS server search
order, enter the LAN IP Address of your [ |
router (192.168.0.1). Click Add.

m
Birddrgs Aearced | 8IS
NS Conbguralon |am|muswﬁ-|mm
Step 5 Click OK twice. e

When prompted to reboot your computer, Hod [aien D |
click Yes. . DN |
After you reboot, the computer will now T |
have a static, private IP Address. —

|

[ ||

Step 5 Access the web management. Open your web

browser and enter the IP Address of your D-Link device in o | e |
the address bar. This should open the login page for the

web management. Follow instructions to login and complete the configuration.
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(IE AT&T-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based configuration by typing in the IP Address of the
router (default:192.168.0.1) in your web browser. The username is admin (all

lowercase) and the password is blank (nothing).

Connect to 192.168.0.1
= -

Step 2 Click the Home tab and click the =
‘5.1_"'5?\.

WAN button. Dynamic IP Address is the
default value, however, if Dynamic IP Address
is not selected as the WAN type, select
Dynamic IP Address by clicking on the radio
button. Click Clone Mac Address. Click

on Apply and then Continue to save the

changes.

Dil-524

User name: | € admin ~|

Password: [ |

[[1Remember my password

D-Link

Bulng Networks for People

Air-Plus G
802.11g/2.4GHz Wireless Router

Advanced Tools Status  Help

Home

DI-524 I

VAN Settings
Flease select the appropriate option to connect to your ISP

Choose this option to obtain an IP address automatically
from your ISP. (For most Cable moderm users)

Choaose this option to set static IP infarmation provided to

® Dynamic IP Address

Wizard

oL f

() Static IP Address

you by your ISP,

O PFPOE Choose this option if your ISP uses PPPoE. (For mast DSL
Wireless users)
() Others FPTP , BigPond Cahble , L2TP and Telia.
WAN
Add
T Host Name \ | optionan
MAC Address |
o Hso Lpie Lz Ler lss
e
DHCP
Primary DNS Address 0000 |
Secondary DNS Address 0000
MTU 1500 |

Auto-reconnect

) Enatled & Disabled

@ © 0O

Apply Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

Turn the cable modem off (first) . Turn the router off Leave them off for 2 minutes.**
Turn the cable modem on (first). Wait until you get a solid cable light on the cable
modem. Turn the router on. Wait 30 seconds.

** If you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the
Status tab and click the Device Info button. If you do not already have a public IP

Address under the WAN heading, click on the DHCP Renew and Continue buttons.
Static Cable Connection

Step 1 Log into the web based configuration
by typing in the IP Address of the router

Connect to 192_168.0.1

(default:192.168.0.1) in your web browser. The ?\
username is admin (all lowercase) and the
password is blank (nothing). DhgE
User name: | €8 =cmin
password: [ |
Step 2 Click the Home tab and click the WAN i —
button. Select Static IP Address and enter your
static settings obtained from the ISP in the fields
provided.
D-Link ~
If you do not know your S m——— MAirPlus G
settings, you must contact o "“"" L IShE VI "”“'
yOUr |SP e i IHOII.IG vance Tools Status elp
‘- " I'--es.ée sei!c‘t‘lne appropriate option to connect 10 your ISP,
- o Dymamic IF Address Choose Mis opbion 1o cbtain an IF acdress automatically
§ Tram your I:'il" {Far l.mHI r.'nél.e.m:!ﬂnmlfsenrs) z
i - @ Blaic 1P Address :‘;:::ls;:;:l;:;;;rn::ln.u sl sdalic IP indormation provided o
Step 3 CIICk on Apply and ) PPPOE ﬁ'f'?'?’;ews QPN your ISP uses PPFOE. (For most DL
then click Continue to save ) Ot PPTI:—‘.RigPuru!ﬁul:'-:.l?TP and Telia,
the changes. WAN
'T 1P Asidraess annn
Step 4 Click the Status Site
. . T aliews e
tab and click the Device e =
|nf0 button YOUF IP AddreSS Secondary DNE Addiess 00ng
information will be displayed L] (T
under the WAN heading. .
g @ 90
Apply Cancel Help




Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into
the address window and hit the Enter key. When the password dialog box appears,
enter the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 In the username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,

please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an |IP Address.

Can | use my D-Link Broadband Router to share my Internet connecti¢n
provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1 Log into the web-based configuration (192.168.0.1) and configure the WAN
side to use PPPOE.

Step 2 Enter your screen name followed by @aol.com for the user name. Enter
your AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything
higher than 1400.

Step 4 Apply settings.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different internet service provider and want
to use the AOL software, you can do that without configuring the router’s firewall
settings. You need to configure the AOL software to connect using TCP/IP.

Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web

browser and enter the |P Wirtual Server is used to allow Internet users access to LAN senices
Address of your D-Link router & Enabled © Disablad
(192.168.0.1). Enter username Name [poamwneel Clear |
(admin) and your password Private I 182.168.0.100
(blank by default)- Frotocal Type  |UDP 'l

Private Port 22
Step 2 Click on Advanced Pulic Port [ iZ

on top and then click Virtual Schecle @ Aways

Server on the left side. € From time [00 =] : [007=] [am =] to [00 =] - [00 =] [ =]

Step 3 Check Enabled to soy[Son 2 vofEun =]
activate entry.

Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone
that was set up between North Korea and South Korea following the UN police action
in the early 1950s.) A DMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access
to Web sites or other companies accessible on the public network. The DMZ host
then initiates sessions for these requests on the public network. However, the DMZ
host is not able to initiate a session back into the private network. It can only forward
packets that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served

to the outside world. However, the DMZ provides access to no other company data.
In the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

a DMz

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the
local network. The DMZ, or Demilitarized Zone, will allow the specified computer
to be exposed to the Internet. DMZ is useful when a certain application or game
does not work through the firewall. The computer that is configured for DMZ will be
completely vulnerable on the Internet, so it is suggested that you try opening ports
from the Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.
To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x

or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based configuration ReliE=azREFEIHE]
of the router by typing in the IP Address = M
of the router (default:192.168.0.1) in your "215'1 L
web browser. The username is admin (all
lowercase) and the password is blank

(nothing)

DI-524

User name: |ﬁ admin v|

Password: | |

[C1Remember my password

[ Ok ] [ Cancel

Step 3 Click the Advanced tab and then click on the DMZ button. Select Enable
and type in the IP Address you found in step 1.

D-Link

BUIKImg Netwarks for Peopie ﬁ-plus G

step 4 Click App|y 802.119/2.4GHz Wireless Router
i Hor Tools Status | Hel
and then Continueto | BLIIT Advanced P
save the changes.
=< = DMZ{Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to

‘,”",J' the Intemet
Note: When DMZ is _
enabled, Virtual Server - & ol ED o

. . . |P Address 192.168.0/

settings will still be
effective. Remember, 9 60
you cannot forward the Aol Cancal, Halp
same port to multiple
IP Addresses, so the
Virtual Server settings :
will take priority over
DMZ settings. =

=
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Frequently Asked Questions (continued)

How do | open a range of ports on my DI-524 using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.

Step 2 From the web management Home page, click the Advanced tab then click
the Firewall button.

Step 3 Click on D-Link ~ »
Enabled and type in a [IEEREEEIEs AirPlus G

name for the new rule. 802.11g/2.4GHz Wireless Router
| Home [WUIFILTLR Tools | Status Help

D

T
b4
=

Firewall Rules can be used to allow or deny traffic from passing through the D524

Step 4 Choose WAN
as the Source and
enter a range of IP

OEnabled O Disabled

Virtual Server aine |

il

Addresses out on the action O Alow O Deny

internet that you would Application . :\l:ten’acj I\P Starl ‘ I\P End Protocol  Port Range
Ilke thls rUIe applled Filter Destination 1'7:; F;i '
to. If you would like SR @

this rule to allow all Firewall O From HERTERT

internet users to be [sun_¥1o[sun v

able to access these 2L, 2 O O

I

ports, then put an Apply Cancel Help

Asterisk in the first

DMz

Action Name Source Destination Protocal

arm—
box and leave the Allaw Allow to Ping WAN port WAN," VAN ICNP,8 [Ef]
second box empty. Deny Defaut L B

Allow Default LAN™ £¥: - Hm

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming service.

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer

and then open port 81 to the other computer. 80



Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an
FTP Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and
a VPN server at 192.168.0.7, then you need to specify the following virtual server
mapping table:

Ceoron | s |

21 192.168.0.5 X
80 192.168.0.6 X
1723 192.168.0.7 X

How do | use PC Anywhere with my DI-524 router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.

Step 1 Open your web browser and enter the IP Address of the router
(192.168.0.1).

Step 2 Click on Advanced at the top and then click Virtual Server on the left side.

Step 3 Enter the Virtual Server _
information as seen Yirtual Server is used to allow Internet users access to LAN services.
below. The Private IP @ Enabled ¢ Disabled
is the IP Address of the Name [peanywhere1 Clear |
computer on your local Private IP [18z 1680100
network that you want Protacal Type ITP;,
to connect to. Private Port  [22

Public Port 22
Step 4 The first entry Schedule & Always
will read as shown here: ¢ From time [002]  [00.=] [AM =] 1o [00 =] . [00 =] [AM =]

day m to m

Step 5 Click Apply
and then click Continue. 81



Frequently Asked Questions (continued)

How do | use PC Anywhere with my DI-524 router? (continued)

Step 6 Create
a second entry Yirtual Server is used to allow Internet users access to LAN services.

as shown here: & Enabled ¢ Disabled

Marme |poanywhere? Clear |
Private IP |192.1EB.D.1DD

Fratocol Type ITCP 'l
Private Port |5631

Step 7 Click Public Port  [5631
Apply and then Schedule & Always
click Continue. € From tirne |00 =] - [00 =] |AM =] 1o [00 =] Jo0 =] [aM =]

day|5un vImISun vl

Step 8 Create . ] ,
a third and final Yirtual Server is used to allow Internet users access to LAN serices.

entry as shown

@ Enabled © Disabled
here:

Mame |pc:anywher93 Clear |

Private IP 192.166.0.100

Protacol Type Im
Private Port W
Public Pot  [5632
Schedule & Always
€ From time |00 7] - [00 =] |AM =] 1o |00 x| - f00 ~] [AM =]
day [Sun 2] to[5un 7]

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address.
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Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link Router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.

Step 3 Create a . 4
new firewall rule: R;Il:ulﬂmkw AirPlus G

Click Enabled. 802.11g/2.4GHz Wireless Router
Enter a name

Tool Stat ]
(edonkey). e ] m Advanced ools atus p
CIle A"OW ‘- : Firewall Rules can be used to allow or deny traffic from passing through the DI-524.
Next to SOUI"CG, @ Enanled O Disabled
select WAN under Wame  [emwer
interface. In the Action @ o O Deny
fiI'St bOX, enter an * Fnteﬁacel I\P Start IP End Protocol  Port Range
L th d Source |wan v || I ‘
beave tesecon Destination |Lan v | [192168.0100 | | | [+ e [smm ases |

OX emp y . . Schedule @ Abways

Next to Destination, Firowal O Fom  Tims [0 %[00 whro[s0 %[00 %]
select LAN under say[5n ¥Jo[on 9]
interface. Enter the (VI +
IP AddreSS Of the 'T Apply Cancel Help
computer you are . .

i e ——— Action Name Source Destination Protocal
running eDonkey Allow Allow to Ping WaAN port Wian = AN, ICMP,8 2§ ]
from. Leave the R Lt @i
second box empty. Allow Default LAN,* = o [

Under Protocol,
select *. In the port range boxes, enter 4661 in the first box and then 4665 in the

second box. Click Always or set a schedule.

Step 4 Click Apply and then Continue.
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 2?

To allow you to play SOCOM and hear audio, you must download the latest firmware
for the router (if needed), enable Game Mode, and open port 6869 to the IP Address
of your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router
(192.168.0.1). Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue

D-Link _ .
Buidmg Netwarks for Feople ﬂrpl us G
802.11g/2.4GHz Wireless Router
BTN Advanced [T Status Help
DI-524 l

Wirual Server is used to allow Internet users access to LAM services

¢

@Enabled O Disabled

Virtual Server Narme fscom ]
Private IP 192,168 UD|
Protocol Type [ Bt |
Private Port @
Public Part @
Schedule @ Always
e

s O From  Tima |00 %[00 [¥Ta[0 %[00 9]
ay[sin ¥]1o[sen ]
DDNS .

DMz Apply Cancel Help

[

Performance Mame Private IP Protocol Schedule

[

Virtual Server FTP nnno TCP21/21 always EV]
vittual Server HTTF 0.00.0 TCR80/80  always EL}
vitual Server HTTPS 0.0.0.0 TP 4430443 always )]
Virtual Server OMS nnno UDP53(63  always EV}

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply and
then Continue. 84




Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Open your web browser and enter the IP Address of the router
(192.168.0.1). Enter admin for the username and your password (blank by default).

Step 2 Click on the Advanced tab and then click Virtual Server on the left side.

Step 3 You will create 2 entries.

Step 4 Click Enabled and enter Settings:

NAME - Gamespy1

PRIVATE IP - The IP Address
of your computer that you are
running Gamespy from.

PROTOCOL TYPE - Both

PRIVATE PORT - 3783
PUBLIC PORT - 3783
SCHEDULE - Always.

Click Apply and then continue

Step 5 Enter 2nd entry:
Click Enabled

NAME - Gamespy?2

PRIVATE IP - The IP Address
of your computer that you
are running Gamespy from.

PROTOCOL TYPE - Both
PRIVATE PORT - 6500
PUBLIC PORT - 6500
SCHEDULE - Always.

Click Apply and then continue.

AirPlus G

802.11g/2.4GHz Wireless Router
| Home RULTTER Tools  Status Help
Virtusl Server 18 used 1 aliow Inlemel Users access 1o LAN semites.

@Enatua O Disabled

Hamo it
Errvite IF 142 165 0/190
Protcoi Tme [ Bun v
PratePot [
Fubli: Fort
Schedule & Awwarys
Fom  Tima |00 %[0
day| S ¥ oS
@ 90
Apply Cancel Help
Pt Protocel Schadiln
LET] TEFHIN abways £} |
noon TCRROGED  ahways 2} |
noon TCP 4141 abways =4
noon UDFSIIST  shamys 44

W AirPlus 5 .
802.11g/2.4GHz Wireless Router

Tools

SLIIIN Advanced

Vitual Sanver i UEed 1 allow Intamst USATS Access 1o LAN sereces

Status Help

@ Enabled O Disatied

Hama el
Frivatn 7 192 168 0100
Prifosol Tree | Ban
Frwvate Fot 8500
Furiic Port 5500
Schedule & Awys
O Frem Teme |00 98] 00 9ifr (o0 %0 =
day[Son ¥ o[ &
2 90O
Apply Cancel Help
b Privile i Protoeol Sechedule
\irtual Sarver FTP anag TCRTIT  awars 45
Virtual Server HTTP 6000 TCPODIBD  ahwars £} ]
il Berr MTTPE 0000 TCR 8431443 atwars 4 )
\itual Sarves ONE LTI UDPS3I53  abwars |

85




Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the Kazaa
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (kazaa for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

| Home FUTTITYR Tools  Status Help
VinuaI'Ser\rer is usedto allow Internet users access to LAN serices.

®Enabled O Disabled

Mame |kazaa |

Private IP 192.168.0/100 |
Protocol Type ITCP_v;

Private Port [1214 |
Public Port 1214 |
Schedule ® Always

1T I
O From  Time|00 w00 wiro|o0 w| 00 v|

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

D-Link AirPlus G
802.11g/2.4GHz Wireless Router
oo | | DI Advances

Virtual Bereer i usied to allow infemel users access In LAN senices

For the DI-604, DI-614+. DI-524,
DI-754, DI-764, or DI-774:

Step 1 Open your web browser
and enter the IP Address of
your router (192.168.0.1). Enter

& Enatied ) Disabied

Name sty

username (admin) and your Pt 1g21a00[0
Protocol Type: Both W
password (leave blank). SR | (=
Puble Pont 2
Step 2 Click on Advanced and A oY R
then click Virtual Server. w50 ¥up[sm ¥

- 2 © O
ly Cancel Hel
Step 3 Create a new entry: o i

Click Enabled. Enter a name

DEEEED: €

MNama FPrivate [P Protocel Sthedule

: Wirtyal Seeves F TP 0.0.00 TR ahwavs 44
(warcraft3). Private IP - Enter the DR TGRRI s -
IP Address of the computer you sl o a9

want to host the game. Select
Both for Protocol Type Enter 6112 for both Private Port and Public Port Click Always
or set a schedule.

Step 4 Click Apply and then Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
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Frequently Asked Questions (continued)

How do | use NetMeeting with my D-Link Router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs
like Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or
other h.323 software packages.

The solution is to put the router in DMZ.

Note: A few hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients

Step 1 Open your web browser and enter the IP Address of your router

(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

(continued)

How do | set up my router to use iChat? -for Macintosh users-

Step 3 Create a new firewall rule:

Click Enabled. D-Link
Enter a name
(ichat1).

Click Allow.

Next to Source,

DI-524 b

select WAN under
interface. Frcoacadon
In the first box,
enter an *.
Leave the second PUSHEN
box empty.
Next to Destination, ﬁ
select LAN under .
interface. bl
Enter the IP

Address of the

AgPlus G
802.11g/2.4GHz Wireless Router
m Advanced a0 Status Help
: I.r.l 'w..:.lll Hl‘ll:.‘l!:;.:;ln B used 10 allow ar deny ramc from passing throwgh the 0524

& Enabled ) Disabled

Nami enaet
Action @ aow O Dy
Imerface  |P Stan IP End Protocol  Pon Range
Sourca WAN
Destination | Lan % 1921600100 e | (oo L
Schedule @ Atways
) From  Time (00 |00 T |00 % 00w
day|Sun ¥ o[ Sun v
Apply Cancel Help

Irewall Rules LI

Action Name. Source Destination Profocol

Al Al o Fing VAN port VRN WAN,T ICMP 8 350

Dany Default e LAR, - £} )

Allow Dufaull LA = 40

computer you are running iChat from.

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.

Click Always or set a schedule.

Step 4 Click Apply
and then Continue.

BiE ¢

step 5 Application

Repeat steps 3 and 4 Fittor

enter ichat2 and open —

ports 16384-16403

(UDP). =
™ omz
et emases’

AarPlus S
802.11g/2.4GHz Wireless Router

BT Advanced ERECTE Status

awall Rul
Firirwrall Rules can be used 1o allow or deny traffic friom passing through the D524

Help

@ Enabled O Disabled

Marma ichal?
Action E atow O Deny
Interface [P Stan IP End Protocol  Port Rangs
Source VAN W o
Destination LAN W 1HL 68000 ] UDP  w 16384 - 16400
Schedule ® Arways
) From  Time 00 %100 % To 00 v 00«
day|[Sun v oS =
Apply Cancel Help

wiall Hule 1

AETON M BOouroir DisEnaton Profacol

Allorw Allow to Ping WAN porl VAN, WAN,® ICMP 8 40

Dery Default - LANS . £ ]

Allow Default LAM E ]
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing:
Step 1 Click on

D-Link » -
Advanced and then g Networks foPeople AirPlus G
Virtual Server. 802.11g/2.4GHz Wireless Router
o ! | Home NYPYTN Tools Status Help
tsot:(glvzat(éheencti:yEnabled ‘.~ = F\.rew;\\;u\asdc‘anhausedtna\lnwnrdenytramummpassmgthmughthaDlrEM
' @ Enabled O Disabled
oo ame ic
Step 3 Enter a name for T
our virtual server ent it Interface I Start IF Erd Protocel  Port Range
{ichat3). S - R R
Destination  [Lan_ | [1s2teaoq00 | [ | [1ep | [man [ |
) Schedule @ Atways
Step 4 Next to Private o — O Fom e a0 Vo8 whro [ e ]
IP, enter the IP Address ey ] 105 ]
—_ | ELE |
of the computer on 2 6 0
your local network that e Apply Cancel Help
wan llow th irowall Rules List
you a t to a 0 t e Action Mame Source Destination Pratocal
Incoming service to. Bllow Allowto Ping YiaM port WARLT VAN IcMP,8 £}
Deny Defaul = LN e E{]
Step 5 Select TCP for Al e G mu

Protocol Type.
Step 6 Enter 5190 next to Private Port and Public Port.
Stsp 7 Click Always or configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall is
active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X fire-
wall, the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may
keep the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.
Step 3 Click the Firewall tab.
Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number
5190 should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X
are outlined in technical document 106461, “Mac OS X: File Sharing” in the AppleCare
Knowledge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click

the Firewall tab and select the service you have chosen in the “Allow” list. If you do not
do this, the firewall will also block the file sharing service. *
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. It is proposed and described in
RFC-1631 and is used for solving the IP Address depletion problem. Basically, each
NAT box has a table consisting of pairs of local IP Addresses and globally unique
addresses, by which the box can “translate” the local IP Addresses to global address
and vice versa. Simply put, it is a method of connecting multiple computers to the
Internet (or any other IP network) using one IP Address.

D-Link’s broadband routers (ie: DI-604) support NAT. With proper configuration,
multiple users can access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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